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Preface

This section describes the purpose and organization of this guide: Getting Started 
with Oracle Change Management Pack.  Specifically, it covers the following topics:

■ Purpose of this Guide

■ Audience

■ How this Guide is Organized

■ How to Use this Guide

■ Oracle Enterprise Manager Pack Information

■ Oracle Enterprise Manager Documentation

■ Your Comments are Welcome

Purpose of this Guide
This guide provides an overview of the Oracle Change Management Pack 
applications and their features.  As the guide describes how to use the Oracle 
Change Management Pack applications, it also introduces you to key Oracle 
Change Management Pack concepts and terminology.

Audience
This guide is written for those who want to use any of the Oracle Change 
Management Pack applications.
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Knowledge Assumed of the Reader
This guide assumes you are familiar with the Oracle Enterprise Manager console 
and base applications.  If you are not, please read the Oracle Enterprise Manager 
Concepts Guide and the Oracle Enterprise Manager Administrator’s Guide.

How this Guide is Organized
This guide consists of three chapters and two appendices.

Chapter 1, "Overview of the Oracle Change Management Pack"

This chapter provides an overview of important Oracle Change Management Pack 
concepts and features.

Chapter 2, "Using Change Manager"

This chapter describes how to use Change Manager, the general-purpose interface 
for the Oracle Change Management Pack.

Chapter 3, "Using Plan Editor"

This chapter describes how to modify and create object definitions using the Plan 
Editor application of Oracle Change Management Pack.

Appendix A, "Command Line Interface Appendix"

This appendix describes uses for the command line interface for the Oracle Change 
Management Pack. It also provides syntax and reference information for command 
line interface commands and describes the exit status codes returned by the 
command line interface.   

Appendix B, "Troubleshooting Appendix"

This appendix describes different ways of troubleshooting problems that may occur 
when you are using Oracle Change Management Pack applications.

How to Use this Guide
This guide should be read in its entirety to provide you with an overview of each of 
the Oracle Change Management Pack applications, so that you are familiar with the 
tasks that can be performed with them.  This guide does not describe all the details 
of using the applications.  The online help for the applications provides more 
detailed information about using these applications.
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Oracle Enterprise Manager Pack Information
The Oracle Enterprise Manager product family includes seven packs: Oracle 
Change Management Pack, Oracle DBA Management Pack, Oracle Diagnostics 
Pack, Oracle Management Pack for Oracle Applications, Oracle Management Pack 
for SAP R/3, Oracle Standard Management Pack, and Oracle Tuning Pack.  Each 
pack is fully integrated into the Oracle Enterprise Manager Console framework.

Oracle Change Management Pack

■ Includes Baseline Viewer, Change Manager, DB Alter, DB Capture, DB Diff, DB 
Propagate, DB Quick Change, DB Search, and Plan Editor.

■ Tracks metadata changes in databases.

■ Eliminates errors and loss of data when upgrading databases to support new 
applications.

■ Analyzes the impact and complex dependencies associated with metadata 
change and automatically performs upgrades.

■ Allows you to find the database objects that match a set of search criteria that 
you specify.

■ Initiates change safely with easy-to-use wizards that teach the systematic steps 
necessary to upgrade.

Oracle DBA Management Pack

■ Includes DBA Studio and Oracle SQL*Plus Worksheet.

■ Simplifies DBA operations by allowing you to perform them by pointing and 
clicking with your mouse rather than manually entering SQL commands.

■ Concurrently performs multiple tasks in multiple Oracle Enterprise Manager 
windows.

■ Administers several databases simultaneously.

■ Centralizes database administration tasks for both local and remote databases 
running on any Oracle platform in any location worldwide.

Oracle Diagnostics Pack

■ Includes Oracle Performance Manager, Oracle Capacity Planner, Oracle Trace, 
Oracle TopSessions, and Oracle Event Tests that are provided with the Oracle 
Diagnostics Pack.
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■ Monitors, diagnoses, and maintains the health of databases, operating systems, 
and applications.  Real-time analysis is used to analyze current problems, and 
historical analysis is used to analyze trends that could cause future problems.

■ Provides powerful capacity planning features that enable users to easily plan 
and track future system resource requirements.

Oracle Management Pack for Oracle Applications

■ Includes Oracle Performance Manager, Oracle Capacity Planner, and Oracle 
Event Tests that are provided with the Oracle Management Pack for Oracle 
Applications.

■ Monitors, diagnoses, and maintains the health of Oracle Applications. Real-time 
analysis is used to analyze current problems, and historical analysis is used to 
analyze trends that could cause future problems.

■ Provides powerful capacity planning features that enable users to easily plan 
and track future system resource requirements.

Oracle Management Pack for SAP R/3

■ Includes Oracle Performance Manager, Oracle Capacity Planner, and Oracle 
Event Tests that are provided with the Oracle Management Pack for SAP R/3.

■ Monitors, diagnoses, and maintains the health of an SAP R/3 system. 

■ Provides powerful capacity planning features that enable users to easily plan 
and track future system resource requirements. Real-time analysis is used to 
analyze current problems, and historical analysis is used to analyze trends that 
could cause future problems.

Oracle Standard Management Pack

■ Includes Baseline Viewer, Change Manager, DB Capture, DB Diff, Oracle Index 
Tuning Wizard, Oracle Performance Manager, and Oracle TopSessions.

■ Monitors and diagnoses problems, tunes high impact indexes, and tracks and 
compares changes in your Oracle environment.

Oracle Tuning Pack

■ Includes Oracle SQL Analyze, Oracle Expert, Oracle Index Tuning Wizard, 
Reorg Wizard, and the Tablespace Map.

■ Optimizes system performance by identifying and tuning major database and 
application bottlenecks such as inefficient SQL, poor data structures, and 
improper use of system resources.
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■ Proactively discovers tuning opportunities and automatically generates the 
analysis and required changes to tune the system.  Inherent in the product are 
powerful teaching tools which train DBAs how to tune as they work.

■ Instills "Consultant Quality" tuning expertise into developers and DBAs and 
increases their productivity.

Oracle Enterprise Manager Documentation
The Getting Started with Oracle Change Management Pack manual is one of several 
Oracle Enterprise Manager documents.

Oracle Enterprise Manager base documentation

■ The Oracle Enterprise Manager Readme provides important notes regarding the 
online documentation, updates to the software, and other late-breaking 
information.

■ The Oracle Enterprise Manager Administrator’s Guide explains how to use Oracle 
Enterprise Manager, Oracle’s systems management console, common services, 
and integrated platform tool. This manual also describes how to use the DBA 
Management Pack.

■ The Oracle Enterprise Manager Concepts Guide provides an overview of Oracle 
Enterprise Manager, including the DBA Management Pack.

■ The Oracle Enterprise Manager Configuration Guide explains how to configure 
Oracle Enterprise Manager.

■ The Oracle Enterprise Manager Messages Manual describes the Oracle Enterprise 
Manager error messages and methods for diagnosing the messages.

Oracle Change Management Pack documentation

■ The Oracle Change Management Pack Readme provides important notes regarding 
the Change Management Pack online documentation, updates to the software, 
and other late-breaking information.

■ The Getting Started with Oracle Change Management Pack manual (this manual) 
provides an overview of the concepts and features of the Oracle Change 
Management Pack applications.

Oracle DBA Management Pack documentation

■ The Oracle Enterprise Manager Administrator’s Guide provides information on 
how to use the DBA Management Pack.
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■ The Oracle Enterprise Manager Concepts Guide provides overview information 
about the DBA Management Pack.

Oracle Diagnostics Pack documentation

■ The Oracle Diagnostics Pack Readme provides important notes regarding the 
Diagnostics Pack online documentation, updates to the software, and other 
late-breaking information.

■ The Getting Started with the Oracle Diagnostics Pack manual provides an overview 
of the concepts and features of the Oracle Performance Manager, Oracle 
Capacity Planner, and Oracle TopSessions applications.  It also describes the 
Oracle Event Tests that are provided with the Oracle Diagnostics Pack, which 
allow you to manage database, listener, and service types.

■ The Oracle Trace User’s Guide explains how to use the Oracle Trace application to 
capture and use historical data to monitor Oracle databases.

■ The Oracle Trace Developer’s Guide explains how to instrument your application 
with Oracle Trace routines.

Oracle Management Pack for Oracle Applications documentation

■ The Oracle Management Pack for Oracle Applications Readme provides important 
notes regarding the Applications Management Pack online documentation, 
updates to the software, and other late-breaking information.

■ The Getting Started with Oracle Management Pack for Oracle Applications provides 
an overview of the concepts and features of the Oracle Performance Manager 
and Oracle Capacity Planner.  It also describes the Oracle Event Tests that are 
provided with the Oracle Applications Management Pack.

■ The Oracle Intelligent Agent User’s Guide provides configuration information and 
answers to crucial troubleshooting questions pertaining to the Oracle Intelligent 
Agent.

Oracle Management Pack for SAP R/3 documentation

■ The Oracle Management Pack for SAP R/3 Readme provides important notes 
regarding the Management Pack for SAP R/3 online documentation, updates to 
the software, and other late-breaking information.

■ The Getting Started with Oracle Management Pack for SAP R/3 manual provides an 
overview of the concepts and features of the Oracle Performance Manager and 
Oracle Capacity Planner.  It also describes the Oracle Event Tests that are 
provided with the Oracle Management Pack for SAP R/3.

Oracle Standard Management Pack documentation
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■ The Oracle Standard Management Pack Readme provides important notes 
regarding the Standard Management Pack online documentation, updates to 
the software, and other late-breaking information.

■ The Getting Started with Oracle Standard Management Pack manual provides an 
overview of the concepts and features of Baseline Viewer, Change Manager, DB 
Capture, DB Diff, Oracle Index Tuning Wizard, Oracle Performance Manager, 
and Oracle TopSessions.

Oracle Tuning Pack documentation

■ The Oracle Tuning Pack Readme provides important notes regarding the Tuning 
Pack online documentation, updates to the software, and other late-breaking 
information.

■ Database Tuning with the Oracle Tuning Pack provides an overview of the 
concepts and features of each of the applications in the Oracle Tuning Pack. The 
applications include Oracle SQL Analyze, Oracle Expert, Oracle Index Tuning 
Wizard, Reorg Wizard, and the Tablespace Map. A description of how these 
applications can work together to tune an Oracle database is also provided.

Your Comments are Welcome
We value and appreciate your comments as an Oracle user and reader of the 
manuals.  As we write, revise, and evaluate our documentation, your opinions are 
the most important input we receive.  After the table of contents in our printed 
manuals is a Reader’s Comment Form, which we encourage you to use to tell us 
what you like or dislike about this manual or other Oracle manuals.  If the form is 
not available, please use the following address, FAX number, or electronic mail 
address.

Oracle Corporation
Oracle Change Management Pack Documentation
98 Spit Brook Road, Suite 300
Nashua, NH 03062
U.S.A.

FAX - 603-897-3317  Attn: Oracle Change Management Pack Documentation
Electronic mail - nedc_doc@us.oracle.com
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1
Overview of the Oracle Change

Management Pack

The Oracle Change Management Pack is a group of integrated applications used to 
track and make changes to database object definitions.  The Oracle Change 
Management Pack is a component of Oracle Enterprise Manager.

This chapter provides an overview of important Oracle Change Management Pack 
concepts and features.

The following section describes new features for this release of Oracle Change 
Management Pack.

New Features for This Release of Oracle Change Management Pack
The following list describes the major new features for this version of the Oracle 
Change Management Pack:

■ Change Manager application

Change Manager, a new application, is now the central control panel for Oracle 
Change Management Pack. In most cases, interaction with the Oracle Change 
Management Pack is directly or indirectly through Change Manager.

■ Improved multiple user support

Oracle Change Management Pack provides improved multiple user support. 
Each user has read and write access to the object definitions that he or she 
owns, and has read-only access to object definitions owned by other users. The 
Change Manager navigator tree displays change plans, baselines, and 
comparisons, organized by owner.
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■ Baselines and comparisons can be created from the Oracle Enterprise Manager 
console and from DBA Studio

See "Capturing a Baseline from the Oracle Enterprise Manager Console or DBA 
Studio" on page 1-10 and "Performing a Comparison from the Oracle Enterprise 
Manager Console or DBA Studio" on page 1-12 for more information.

■ History features for Oracle Change Management Pack tasks

You can now view history entries that show the status of the following Oracle 
Change Management Pack tasks:

– Script generation

– Script execution

– Capturing baselines

– Performing comparisons

By viewing the history entries for pending tasks and completed tasks, you can 
determine when each Oracle Change Management Pack task was performed 
and which user performed it. See "Viewing History Entries for Tasks" on 
page 2-8 for more information on history entries for tasks.

■ Launch DBA Studio from Change Manager

You can launch DBA Studio directly from Change Manager to modify database 
objects. On the Change Manager Tools menu, click DBA Studio to start DBA 
Studio.

■ Create and view multiple versions of a baseline

After you create a named baseline specification that describes the object 
definitions to include in the baseline, use the specification as often as you like to 
generate baseline versions that match the baseline specification criteria.

Any  differences between versions of a baseline accurately reflect differences in 
the database contents, not changes to the baseline specification (a baseline 
specification is a read-only object). Storing these baseline versions is an easy 
way to record changes in your database at different times in a development 
cycle.

You can view a particular version of a baseline. See "Working With a Particular 
Version of a Change Plan, Baseline, or Comparison" on page 2-10 for more 
information on viewing baseline versions.

■ Create and view multiple versions of a comparison



New Features for This Release of Oracle Change Management Pack

Overview of the Oracle Change Management Pack 1-3

After you create  a comparison specification that describes the sets of object 
definitions to compare, use the specification as often as you like to generate 
comparison versions that determine the differences between the sets of object 
definitions.

Any differences between comparison versions accurately reflect differences in 
the database contents, not changes to the comparison specification (a 
comparison specification is a read-only object). Storing these comparison 
versions is an easy way to record the differences between two sets of definitions 
at different times in a development cycle.

You can view a particular version of a comparison. See "Working With a 
Particular Version of a Change Plan, Baseline, or Comparison" on page 2-10 for 
more information on viewing comparison versions.

■ Create and view multiple versions of a change plan

Oracle Change Management Pack automatically creates a new version of a 
change plan when necessary to ensure that the history features for change plans 
work properly.

You can view a particular version of a change plan. See "Working With a 
Particular Version of a Change Plan, Baseline, or Comparison" on page 2-10 for 
more information on viewing change plan versions.

■ Command line interface

The new command line interface allows you to:

– Generate and optionally execute a script from a current plan for a single 
named destination database

– Capture a new baseline using a baseline specification

– Perform a new comparison using a comparison specification

Appendix A, "Command Line Interface Appendix" describes how to use the 
command line interface, and includes information on the syntax for the 
command line interface commands.

■ Improved impact report

The impact report now provides more information about why a script action is 
required and how to fix problems in the change plan.

■ Improved failure anticipation for scripts

When a change plan script is generated for a destination database, Oracle 
Change Management Pack can perform more resource checking than in 
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previous releases. Any potential resource problems, for example, a tablespace 
that is too small, that are discovered are reported in the impact report for the 
script.

See "Dealing with Script Execution Errors" on page 3-18 for more information 
on using the OCM_FAILURE_PREDICTION property to improve failure 
anticipation for scripts.

■ View text differences for database object definitions

The DB Diff application now lets you view the text differences in the SQL for 
objects such as check constraints, procedures, functions, packages, trigger 
bodies, and views.

After performing a comparison, select an object pair in the DB Diff tree view 
and in the detail view to the right of the tree view, select the text attribute of the 
object, then choose Show Text Difference on the Tools menu. This option only 
applies to text attributes such as the body of a procedure.

■ Improved user interface for DB Search application

The user interface for the DB Search application has been simplified. The online 
help for DB Search includes more information about the new DB Search 
interface.

■ Exclude the SYS and SYSTEM schemas from an operation

When you capture a baseline using the Advanced mode of DB Capture, search 
for specific database objects with DB Search, or create a scoped directive for a 
plan, the user interface now allows you to specify that you want to exclude the 
SYS and SYSTEM schemas from the operation.

See the online help for more information.

■ Baseline Viewer application

Use Baseline Viewer, a new application, to view baselines.

Database Objects Supported by Oracle Change Management Pack 
Applications

The types of database object definitions that Oracle Change Management Pack 
supports are:

■ Cluster

■ Database link



Database Objects Supported by Oracle Change Management Pack Applications

Overview of the Oracle Change Management Pack 1-5

■ Function

■ Index

■ Package

■ Package body

■ Procedure

■ Profile

■ Refresh group

■ Role

■ Rollback segment

■ Sequence

■ Snapshot

■ Snapshot log

■ Synonym

■ Table

■ Tablespace

■ Trigger and instead-of trigger

■ User

■ View

In this release, Oracle Change Management Pack does not support the following 
features of the database objects in the previous list:

■ Object-oriented features:

– Tables and snapshot logs that refer to user-defined data types.

– Object tables

– Nested tables

– Object views

■ Snapshots that are not read-only

For a more complete list that describes the level of support Oracle Change 
Management Pack offers for specific database objects and attributes, see the section 
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on currently unsupported database features and attributes in the Oracle Change 
Management Pack Readme.

Understanding Oracle Change Management Pack Objects
The following types of objects are created only by Oracle Change Management Pack 
applications and are used to make changes or track changes to other object 
definitions:

■ Change plans

You can use several Oracle Change Management Pack applications to create 
change plans. A change plan is an object that serves as a container for change 
requests. From a change plan, you can generate one or more scripts that can be 
executed to carry out the changes specified in the change plan at one or more 
destination databases. Oracle Change Management Pack applications do all the 
work of determining and ordering the individual steps that must be carried out 
to execute the change requests in the plan. After a script executes at a 
destination database, you have the option of keeping or undoing the changes 
made by the script. See "Using Change Plans to Make Changes" on page 1-19 
for more information about change plans.

■ Baselines

A baseline is a group of database object definitions captured by the Oracle 
Change Management Pack DB Capture application at a particular point in time. 
Each baseline has the name of its baseline specification and a version number. A 
baseline is stored in a format that can be used by multiple Oracle Change 
Management Pack applications.

A baseline specification is used to generate baselines. A baseline specification 
includes a baseline name, source database, scope specification, and owner. The 
baseline name can be changed after the baseline specification is created, but the 
source database, scope specification, and owner cannot. The scope specification 
for a baseline is a set of criteria that an object must meet to be included in the 
baseline generated from the baseline specification. The scope specification 
describes the types of database object definitions to be included in the baseline, 
the schemas in which to look for those object definitions, and the names of 
those object definitions. See "Overview of DB Capture" on page 1-9 for more 
information about baselines.

■ Comparisons
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A comparison identifies the differences found by the Oracle Change 
Management Pack DB Diff application in two sets of database object definitions. 
Each comparison has the name of its comparison specification and a version 
number.

A comparison specification is used to generate comparisons. A comparison 
specification is defined by its name, source database, scope specification, and 
owner. The name can be changed after the comparison specification is created, 
but the source database, scope specification, and owner cannot. The scope 
specification for a comparison is a set of criteria that the set of  objects to be 
compared must meet to be included in a comparison generated from the 
comparison specification. The scope specification describes the types of 
database object definitions to be included in the comparison, the schemas in 
which to look for those object definitions, and the names of those object 
definitions. See "Overview of DB Diff" on page 1-11 for more information about 
comparisons.

Tracking Applications and Change Applications
With Oracle Change Management Pack, you can track changes by:

■ Capturing the current definitions of a set of database objects in a baseline.

■ Creating new versions of a baseline at regular intervals to track changes in that 
set of database objects over time.

■ Comparing a set of object definitions in one schema, database, or baseline to 
another set of definitions (in a schema, database, or baseline) by performing a 
comparison. A comparison finds the differences between the two sets of 
definitions.

■ Creating new versions of a comparison at regular intervals to determine the 
differences between the two sets of definitions over time.

■ Searching for the object definitions in a schema or database that match a set of 
search criteria that you specify.

With Oracle Change Management Pack applications, you can make changes by:

■ After creating a comparison, synchronizing one set of definitions to match the 
other set.

■ Reproducing one or more object definitions in a database at multiple databases, 
which has the same effect as copying definitions from one database to another. 
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If an object definition of the same name and type already exists at the 
destination database, that definition is modified to match the source definition.

■ Modifying one or more object definitions in a database by specifying the 
changes to make.

Figure 1–1 displays the two types of Oracle Change Management Pack applications, 
tracking applications and change applications:

Figure 1–1 Tracking Applications and Change Applications

In Figure 1–1, the left side of the diagram shows Oracle Change Management Pack’s 
tracking applications, which are used to report and track the evolving state of 
metadata in databases. The right side of the diagram shows Oracle Change 
Management Pack’s change  applications, which are used to describe metadata 
changes and execute scripts to carry out the changes.  The DB Diff tool is both a 
tracking application (because its comparison function reports on the state of object 
definitions) and a change application (because its Synchronization wizard is used to 
synchronize one set of object definitions to match the other set of definitions).

■ The tracking applications and their functions are:

– DB Capture

Captures one or more definitions from one database.

– DB Search

Searches for definitions that match a set of search criteria.

– Baseline Viewer

Lets you display baselines created earlier using DB Capture.

– DB Diff

DB Diff

Tracking Applications Change Applications
NU-3698A-AI
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DB Quick Change
DB Alter
DB Propagate
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Compares two sets of definitions.

■ The change applications and their functions are:

– DB Diff’s Synchronization wizard

Modifies a set of database definitions to match another set of database 
definitions.

– DB Quick Change

Modifies one definition in one database.

– DB Alter

Modifies one or more definitions in one or more databases.

– DB Propagate

Reproduces one or more definitions from a database in that database or in 
another database.

– Plan Editor

Allows you to create a change plan, which serves as a container for change 
requests. Scripts can be generated from a change plan, then executed on one 
or more databases to make the changes specified by the change requests.

The Oracle Change Management Pack also contains the Change Manager 
application, which is a general-purpose interface that provides direct or indirect 
access to all Oracle Change Management Pack features. See "Starting Change 
Manager" on page 2-1 for more information on starting Change Manager.

The following sections provide additional overview information on the Oracle 
Change Management Pack applications.

Overview of DB Capture
The DB Capture application guides you through the process of capturing a database 
(or a subset of a database) in a form that is readable by other Oracle Change 
Management Pack applications.  DB Capture lets you specify the set of database 
object definitions to capture, then captures those definitions in their current state at 
the time of the capture operation.

DB Capture can capture object definitions in both of the following forms:

■ A baseline.  The baseline stores definitions in a form that other Oracle Change 
Management Pack applications can use. A baseline is created during every 
capture operation.
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■ A SQL DDL script.  The script contains the SQL statements that correspond to 
the captured definitions. You can use the script to save a textual version of the 
definitions or as input to CASE tools that accept SQL DDL input. You can also 
use individual SQL statements from the script to create definitions in a new 
database. You have the option of whether or not to create a SQL DDL script.

 Figure 1–2 shows the functional capabilities of DB Capture.

Figure 1–2 Functional Capabilities of DB Capture

To view a baseline created with DB Capture, use the Baseline Viewer application.

Capturing a Baseline from the Oracle Enterprise Manager Console or DBA 
Studio
When you have Oracle Change Management Pack installed, you can perform a 
capture operation from the Oracle Enterprise Manager console or DBA Studio by 
following these steps:

1. Select a database, type, or schema folder in the Oracle Enterprise Manager 
navigator or the DBA Studio navigator.

2. Click the right mouse button.

3. On the context menu, point to Change Management, then click Capture 
Database Objects. 

DB Capture is started to capture a baseline for the selected database, then after the 
capture operation is completed, the Baseline Viewer is started to allow you to view 
the baseline.

The online help contains more information about the specifics of using DB Capture.

Overview of Baseline Viewer
The Baseline Viewer application lets you display baselines created earlier using DB 
Capture.

from one databaseone or more
definitions ...
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Figure 1–3 shows the functional capabilities of Baseline Viewer.

Figure 1–3 Functional Capabilities of Baseline Viewer

You can also use Baseline Viewer to generate a SQL DDL script for the baseline if 
you did not generate one when the baseline was captured.

The online help contains more information about the specifics of using Baseline 
Viewer.

Overview of DB Diff
The DB Diff application guides you through the steps of selecting two sets of object 
definitions and then comparing them.  The object definitions can be selected from 
current database definitions or they can be selected from baselines created earlier 
with DB Capture. If differences are found when the two sets of object definitions are 
compared, DB Diff allows you to view the differences between the corresponding 
object definitions.

The result of comparing two sets of object definitions using DB Diff is called a 
comparison. You can name a comparison, save it, and view it later.

Figure 1–4 on page 1-11 shows the functional capabilities of DB Diff.

Figure 1–4 Functional Capabilities of DB Diff

NE-0008A-AI

Displays ... a baseline

two sets of definitions ...

NU-3700A-AI

Compares ...

from different schemas within
a database or baseline, or from
two databases, two baselines,
or a database and a baseline



Tracking Applications and Change Applications

1-12 Getting Started with Oracle Change Management Pack

You can also generate a report in HTML format about a DB Diff comparison.  The 
report includes:

■ A description of what you compared.

■ The comparison options you selected.

■ A summary of the comparison results.

■ The comparison tree and comparison details (optional).

After the two sets of object definitions have been compared, you can use DB Diff’s 
Synchronization wizard to modify one set of definitions (with the exception of 
baselines, which are read-only and cannot be modified) to match the other set of 
definitions.  For each selected object definition in the source, if an object definition 
of the same name and type already exists at the destination database, the 
destination object will be modified to match the source definition.  If a selected 
object definition in the source does not exist at the destination database, it will be 
created.  The Synchronization wizard does all the work of determining and 
ordering the individual steps that must be carried out to perform this requested 
synchronization, taking object definition dependencies into account.

Figure 1–5 shows the functional capabilities of DB Diff’s Synchronization wizard.

Figure 1–5 Functional Capabilities of DB Diff’s Synchronization Wizard

To start the Synchronization wizard for the DB Diff application, on the DB Diff 
Tools menu, click Synchronization Wizard.

Performing a Comparison from the Oracle Enterprise Manager Console or DBA 
Studio
When you have the Oracle Change Management Pack installed, you can perform a 
comparison operation from the Oracle Enterprise Manager console or DBA Studio 
by following these steps:

NU-3701A-AI
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1. Select a database, type, or schema folder in the Oracle Enterprise Manager 
navigator or the DBA Studio navigator.

2. Click the right mouse button.

3. On the context menu, point to Change Management, then click Compare 
Database Objects. 

DB Diff is started to perform a comparison, then the DB Diff viewer is started to 
allow you to view the comparison. If the comparison operation finds that certain 
database definitions are different, you can start the Synchronization Wizard from 
DB Diff if you want to synchronize the definitions.

The online help contains more information about the specifics of using DB Diff and 
the Synchronization wizard.

Overview of DB Quick Change
The DB Quick Change application guides you through the process of making one or 
more changes to a single database object definition.  You indicate changes to object 
definitions by directly manipulating their representation on property sheets similar 
to those in Oracle Enterprise Manager’s DBA Studio application.  The DB Quick 
Change versions of these property sheets allow you to make some changes that 
cannot be made using DBA Studio (for example, changing the name of a column in 
a table).

DB Quick Change does all the work of determining and ordering the individual 
steps that must be carried out to perform your requested operations, taking object 
definition dependencies into account.

Figure 1–6 shows the functional capabilities of DB Quick Change.

Figure 1–6 Functional Capabilities of DB Quick Change

The online help contains more information about the specifics of using DB Quick 
Change.

one definition ... in one database
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Overview of DB Alter
The DB Alter application guides you through the process of making changes to one 
or more object definitions in one or more databases.  You indicate changes to object 
definitions by directly manipulating their representation on property sheets similar 
to those in Oracle Enterprise Manager’s DBA Studio application.  The DB Alter 
versions of these property sheets allow you to make some changes that cannot be 
made using DBA Studio (for example, changing the name of a column in a table).

When you specify a group of changes to several database object definitions, DB 
Alter does all the work of determining and ordering the individual steps that must 
be carried out to perform your requested operations, taking object definition 
dependencies into account.

The specified changes can be applied at the source database and at other databases.

Figure 1–7 shows the functional capabilities of DB Alter.

Figure 1–7 Functional Capabilities of DB Alter

The online help contains more information about the specifics of using DB Alter.

Overview of DB Propagate
The DB Propagate application guides you through the steps of selecting one or 
more object definitions from a database, then reproducing those definitions in a 
destination schema within the source database or in one or more destination 
databases.  For each selected object definition in the source database, if an object 
definition of the same name and type already exists at the destination database, the 
destination definition will be modified to match the source definition.  If a selected 
object definition in the source database does not exist at the destination database, it 
will be created.

DB Propagate does all the work of determining and ordering the individual steps 
that must be carried out to perform your requested operations, taking object 
definition dependencies into account.

in one or more databasesone or more
definitions ...
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 Figure 1–8 shows the functional capabilities of DB Propagate.

Figure 1–8 Functional Capabilities of DB Propagate

The online help contains more information about the specifics of using DB 
Propagate.

Copying Definitions Using Drag and Drop
From the navigator panes in the Oracle Enterprise Manager console and DBA 
Studio, you can select object definitions in a schema, then drag them and drop them 
into a different schema (which can be in a different database). If you drag a 
non-schema object definition, it must be dropped in a different database. When you 
copy table definitions using the drag and drop method, both the table and its 
associated data is copied to the destination. DB Propagate is launched to complete 
drag and drop copy operations. The change plan created by the drag and drop 
operation is deleted, but a history entry for the copy operation is created and saved.

Note: Database links are used to copy table data from one 
database to another.

If you attempt to copy table data from one database to another and 
the impact report includes an ERROR-level message about not 
being able to find a global name for the source database or 
destination database, this means that a database link must be 
created for the database or databases referenced in the error 
message.

See the section on the CREATE DATABASE LINK statement in the 
Oracle SQL Reference Manual for more information on creating a 
database link.

one or more definitions
from a database ...

in a different schema of that
database or in other databases
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Overview of DB Search
The DB Search application lets you search for database objects that match a set of 
search criteria that you specify. After DB Search completes a search operation, you 
can view or modify the object definitions that matched the search criteria.

Figure 1–9 shows the functional capabilities of DB Search.

Figure 1–9 Functional Capabilities of DB Search

The online help contains more information about the specifics of using DB Search.

Overview of Plan Editor
The Plan Editor application allows you to create, modify, and deploy a single 
change plan. The change plan can modify or reproduce database object definitions 
in one or more databases.

You can also create change plans with DB Diff’s Synchronization wizard, DB Alter, 
DB Quick Change, and DB Propagate. However, these applications differ from Plan 
Editor because each of them is designed to create a change plan with specific types 
of change requests that make specific types of changes.

Plan Editor is a more flexible change plan tool. You can use Plan Editor to create 
and modify a change plan that includes any type of change request and which can 
make a wider variety of changes.

The other applications use components from the Plan Editor interface in a 
framework that guides you through the application’s task.  As you use the other 
Oracle Change Management Pack applications, you become familiar with the 
components that Plan Editor uses to accomplish different tasks.

Figure 1–10 shows the functional capabilities of Plan Editor.

the definitions in a
database ...

that match the set of search
criteria that you specify

NE-0001A-RA

Finds ...



Tracking Applications and Change Applications

Overview of the Oracle Change Management Pack 1-17

Figure 1–10 Functional Capabilities of Plan Editor

See Chapter 3, "Using Plan Editor" on page 3-1 for more information on using Plan 
Editor.

Overview of Change Manager
The Change Manager application is the Oracle Change Management Pack central 
interface.  In most cases, Change Manager gives you direct or indirect access to 
Oracle Change Management Pack operations.

Using Change Manager, you can view Oracle Change Management Pack objects 
(change plans, baselines, and comparisons), as well as check on the status of current 
tasks. You can also view history information that tells you which Oracle Change 
Management Pack operations were performed by what users at what time.

Figure 1–11 shows the functional capabilities of Change Manager.

Figure 1–11 Functional Capabilities of Change Manager

See Chapter 2, "Using Change Manager" on page 2-1 for more information on using 
Change Manager.

Starting the Oracle Change Management Pack Quick Tour
The Oracle Change Management Pack includes a Quick Tour that provides an 
overview of the Pack and its components. The Quick Tour is an excellent way to 
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start learning about the applications in the Pack and their uses. To start the Quick 
Tour, on the Start menu, point to Programs, then to the Oracle Home where Oracle 
Enterprise Manager is installed, then to Change Management Pack, then click 
Change Management Quick Tour.

Sample Uses for the Oracle Change Management Pack
Some of the common usage scenarios for the Oracle Change Management Pack are:

■ Using DB Capture to capture a baseline of the current state of database object 
definitions, then using DB Diff later to compare the baseline to the current state 
of those database definitions.

■ Using DB Capture to create a baseline specification that describes the object 
definitions that you want to include in the baseline, then using the specification 
multiple times to create new versions of the baseline. The definitions included 
in the baseline versions may differ over time, as changes are made at the source 
database being used. These baseline versions can be stored by Oracle Change 
Management Pack, making them an easy way to record important points in a 
development cycle.

■ Using DB Diff’s Synchronization wizard to synchronize the current schema or 
database with a previously-captured baseline of the schema or database. If you 
capture a set of object definitions for a schema or database in a baseline, you can 
use the Synchronization wizard later to return those object definitions to the 
state they were when the baseline was captured.

■ Using DB Diff to create a comparison specification that describes the sets of 
object definitions that you want to compare, then using the specification 
multiple times to create new versions of the comparison. The differences found 
during each comparison may change over time, as changes are made to the sets 
of definitions being compared. These comparison versions can be stored by 
Oracle Change Management Pack, making them an easy way to record changes 
to sets of definitions at different points in a development cycle.

■ Using DB Quick Change to make one or more changes to a single database 
object definition, then executing those changes.

■ Using DB Alter to specify changes to one or more object definitions in a single 
database, then executing those changes as a unit

■ Using DB Propagate to simplify database life cycle activities such as:

– Reproducing database object definitions for developers to modify in 
conjunction with enhancements to an application.
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– Reproducing the developers’ enhanced object definitions back at the 
original database after the developers are satisfied with their modifications.

– Reproducing a set of object definitions from a development database to a 
test database and later to multiple production databases.

– Reproducing needed object definitions when deploying a new or upgraded 
application to multiple production databases.

■ Dragging a database object from the Oracle Enterprise Manager console 
navigator or from the DBA Studio navigator, then dropping it in a new schema 
or database in the tree. A drag and drop copy operation displays the DB 
Propagate application, in which you complete the copying of the database 
definition. Note that when you drag and drop table definitions, both the table 
definition and its associated data is copied to the destination. Note that 
database links are used to copy table data from one database to another.

■ Using the history features in Change Manager to track the status of Oracle 
Change Management Pack tasks performed by your users.

Using Change Plans to Make Changes
This section provides an overview of the process of creating and modifying object 
definitions using change plans.  It introduces you to important Oracle Change 
Management Pack concepts and terms.

The process for making changes using change plans involves these phases:

1. Planning and defining changes

2. Evaluating the impact of changes

3. Implementing changes

The following sections describe each of these phases. Note that although change 
plans can be created with the DB Alter, DB Quick Change, DB Propagate, and Plan 
Editor applications, some of these applications may hide various phases of the 
process from you to reduce the time it takes to make the desired changes.

Planning and Defining Changes
The first phase of using a change plan to create or modify object definitions is to 
plan and define the changes that you want to make.

During the planning stage, you plan the changes that you want to make. For 
example, you may want to make one or more changes to an existing object 
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definition in one or more databases. Or, you may want to reproduce one or more 
object definitions from one schema or database in another schema or database.

During the definition stage, you use Oracle Change Management Pack to create a 
change plan and change requests, and you specify one or more destination 
databases. A change plan is a named container for change requests. Change 
requests describe to Oracle Change Management Pack the types of changes that you 
want to make. A destination database is a database where you want to apply the 
change requests in a change plan. See "Creating a Plan with Plan Editor" on page 3-2 
for more information about creating a change plan. See "Selecting a Destination 
Database with Plan Editor" on page 3-11 for more information about selecting a 
destination database.

To specify one or more changes to make to an existing object definition in one or 
more databases, you create a change request called a directive that Oracle Change 
Management Pack uses to make the changes. To reproduce one or more object 
definitions from one database or schema in another database or schema, Oracle 
Change Management Pack uses a change request called an exemplar. See "Defining 
a Directive with Plan Editor" on page 3-5 for more information about defining 
directives. See "Defining an Exemplar with Plan Editor" on page 3-8 for more 
information about defining exemplars.

Figure 1–12 shows the planning and defining changes phase:

Figure 1–12 Using a Change Plan: Planning and Defining Changes

Evaluating the Impact of Changes
After you finish planning and defining the changes, the next phase of the process is 
to evaluate the impact of the changes that you want to make.
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To evaluate the impact of the change requests at a particular database, you use 
Oracle Change Management Pack to generate a script and an impact report for a 
change plan and that destination database. The impact report explains the changes 
that will be made by the script when it executes at the destination database. It also 
describes any change requests that cannot be applied at the destination database, 
and explains how to modify the destination database or change plan so that those 
changes can be made. See "Viewing the Impact Report and Script Summary with 
Plan Editor" on page 3-14 for more information about the impact report.

The script is used to implement the desired changes at the destination database. See 
"Generating a Script with Plan Editor" on page 3-12 for more information about 
generating a script for a destination database.

Figure 1–13 shows the evaluating the impact of changes phase:

Figure 1–13 Using a Change Plan: Evaluating the Impact of Changes

Implementing the Changes
The last phase of the process is to implement the changes.

To implement the change requests in a change plan at a destination database, you 
use Oracle Change Management Pack to execute the script at the destination 
database. See "Executing the Script with Plan Editor" on page 3-16 for more 
information about executing a script at a destination database.

During or after script execution, you can examine the execution log, which displays 
messages, including the status of the script execution ("Script execution succeeded" 
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or "Script execution failed."). See "Dealing with Script Execution Errors" on 
page 3-18 for more information on understanding execution log error messages.

You are also able to keep or undo the changes made by the script at the destination 
database. See "Executing the Script with Plan Editor" on page 3-16 for more 
information about keeping or undoing changes made by a change plan script.

Figure 1–14 shows the implementing the changes phase:

Figure 1–14 Using a Change Plan: Implementing the Changes

Learning More About Making Changes Using Change Plans
The DB Alter, DB Quick Change, and DB Propagate applications guide you through 
the steps of making particular types of changes. Plan Editor allows you to make a 
wider variety of changes, but does not guide you through the steps of making the 
changes.

For more information about making changes using Plan Editor, see Chapter 3, 
"Using Plan Editor" on page 3-1.

Using Help
Online help is provided for all of the Oracle Change Management Pack 
applications. You can display either the Contents page of the Oracle Change 
Management Pack help system, or you can display a help topic for your current 
context in an application.
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Displaying the Contents Page for Help
Depending on the application that you are using, you can display the Contents page 
for the Oracle Change Management Pack online help by using one of the following 
methods:

■ Press F1. If the Contents page for the help system does not display, click the 
Navigator button on the Help Topic Window toolbar.

■ Click the ? on the application toolbar. This applies to Change Manager, Plan 
Editor, Baseline Viewer, and DB Diff only.

■ On the Help menu, choose Contents. This applies to Change Manager, Plan 
Editor, Baseline Viewer, and DB Diff only.

Use the help system’s Contents page, Index page, or Help Search page to locate help 
topics of interest. To access the Help Search page, on the Help Navigator window’s 
Tools menu, choose Search.

Displaying a Help Topic for Your Current Context in an Application
You can display context-sensitive help in several ways, depending on your context 
in an application.

■ If a Help button exists, click it.

■ If a Help button does not exist, click the object that you are interested in, then 
press F1.

■ Some wizard pages for the Oracle Change Management Pack applications also 
display property pages. To access help for the wizard page, click the Help 
button at the bottom left corner of the page. To access help for a property page, 
click a field in the property page, then click the Help button beneath the 
property page. If a Help button does not exist beneath the property page, click a 
field in the property page, then press F1.

Finding a Particular Type of Help Topic
In addition to providing context-sensitive help, the Oracle Change Management 
Pack help system contains conceptual topics, task topics, and a glossary. To locate 
each type of topic:

■ Help topics whose titles begin with words such as "About," "Introduction,"or 
"Overview" are conceptual topics. These topics usually provide overview 
information about Oracle Change Management Pack applications or conceptual 
information that you should be aware of before performing a particular task. 
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They do not provide step-by-step instructions for accomplishing a task. The 
Conceptual Topics book on the help system’s Contents page includes all of the 
conceptual topics in the Oracle Change Management Pack help system.

■ Help topics whose title begin with the word "To" are task topics. These topics 
provide step-by-step instructions for accomplishing a task. They do not provide 
conceptual information that you should be aware of before performing the task. 
The Task Topics book on the help system’s Contents page includes all of the 
task topics in the Oracle Change Management Pack help system.

■ The Oracle Change Management Pack glossary is available by accessing the 
Glossary book on the help system’s Contents page.
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2
Using Change Manager

The Change Manager application is the Oracle Change Management Pack central 
interface.  Change Manager gives you direct or indirect access to all of the Oracle 
Change Management Pack operations (in cases where Change Manager cannot 
directly perform an operation, such as capturing or comparing object definitions, 
Change Manager starts the application that performs that operation).

Change Manager provides access to all the Oracle Change Management Pack 
objects owned by all users, and allows appropriate operations on these objects 
depending on ownership.

Objects are ordered by owner in the Change Manager navigator tree. Each user has 
read and write access to the object definitions that he or she owns, and has 
read-only access to object definitions owned by other users.

Starting Change Manager
You can start the Change Manager application in any of the following ways:

■ From the Oracle Enterprise Manager console, use any of these methods:

– Select a database in the navigator panel, click the right mouse button, point 
to the Related Tools menu option, then click Change Manager.

– On the Tools menu, point to Change Management Pack, then click Change 
Manager.

– Click the Change Management Pack drawer, then click the Change 
Manager icon.

■ On the Windows Start menu, point to Programs, then to the Oracle Home 
where Oracle Enterprise Manager is installed, then to Change Management 
Pack, then click Change Manager.
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See "Starting Change Management Pack Applications from Change Manager" on 
page 2-3 for more information on starting the other Change Management Pack 
applications from Change Manager and "Starting DBA Studio from Change 
Manager" on page 2-4 for more information on starting DBA Studio from Change 
Manager.

Using the Change Manager Main Window
The Change Manager main window (see Figure 2–1) has a navigator tree on the left 
and a detail view on the right.

Figure 2–1 Change Manager Navigator Tree and Detail View

The navigator tree displays the following Oracle Change Management Pack objects, 
organized by owner:

■ baselines
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■ comparisons

■ change plans

If the Change Manager navigator tree contains no objects, this means that no change 
plans, baselines, or comparisons have been created in the Oracle Enterprise 
Manager repository that Change Manager is connected to. When you create these 
objects, they appear in the Change Manager tree.

When you select a Change Management Pack object or object folder and click the 
right mouse button, a context menu is displayed that lists the operations that can be 
performed in the current context. If you select an object that you do not own, some 
of the operations on the context menu are unavailable (for example, you cannot 
remove or modify an object that you do not own, because you have read-only access 
to objects owned by other users). On the context menu, choose any available 
operation that you are interested in performing.

When the Change Manager Users folder (the root of the Change Manager tree) is 
selected (as in Figure 2–1), the detail view provides information about Oracle 
Change Management Pack applications and the operations that they can perform. 
Click on an application’s icon in the detail view to learn more about the operations 
that the application can perform.

When other folders or objects are selected in the Change Manager tree, the detail 
view provides related information about the selected folder or object.

Starting Change Management Pack Applications from Change Manager
You start the other Oracle Change Management Pack applications from Change 
Manager, as follows:

■ Baseline Viewer

Expand the Change Manager folder, user folder, and Baselines folder in the 
Change Manager tree, select a baseline, then on the Object menu, click View 
Baseline.

■ DB Alter

On the Change Manager Tools menu, click DB Alter.

■ DB Capture

On the Change Manager Object menu, click Create Baseline.

■ DB Diff
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On the Change Manager Object menu, click Compare Database Objects.

■ DB Propagate

On the Change Manager Tools menu, click DB Propagate.

■ DB Search

On the Change Manager Tools menu, click Find Database Objects.

■ DB Quick Change

On the Change Manager Tools menu, click DB Quick Change.

■ Plan Editor

On the Change Manager Object menu, click Create Change Plan, then in the 
Create Change Plan Options dialog box, click Create Change Plan Manually.

Starting DBA Studio from Change Manager
In some cases, you may want to start DBA Studio to quickly create or modify object 
definitions. To start DBA Studio from Change Manager, on the Tools menu, click 
DBA Studio.

Working with Baselines
Table 2–1 describes how to use Change Manager to perform different types of 
baseline operations.

Table 2–1 Performing Baseline Operations 

Operation Steps for Performing the Operation

Create a new baseline On the Change Manager Object menu, click Create Baseline 
and follow the steps in the DB Capture application.

View a baseline Select the baseline in the tree. On the Change Manager Object 
menu, click View Baseline.

Delete a baseline Select the baseline in the tree. On the Change Manager Object 
menu, click Remove. This deletes all the versions of the 
baseline.

Export a baseline to a file On the Change Manager Tools menu, click Export 
Plans/Baselines/Comparisons, then specify the baseline to 
export and the name of the export file.
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For more information on working with baselines, see:

■ "Viewing History Entries for Tasks" on page 2-8 for more information on 
viewing history entries for baseline tasks.

■ "Working With a Particular Version of a Change Plan, Baseline, or Comparison" 
on page 2-10 for more information on working with particular versions of 
baselines.

■ "Exporting and Importing Change Plans, Baselines, and Comparisons" on 
page 2-11 for more information on exporting and importing baselines.

Working with Comparisons
Table 2–2 describes how to use Change Manager to perform different types of 
comparison operations.

Import a baseline from a 
file

On the Change Manager Tools menu, click Import 
Plans/Baselines/Comparisons, then specify the name of the 
export file and the baseline to import.

Create a new version of a 
baseline

Select the baseline in the tree. On the Change Manager Object 
menu, click Recapture.

View a previous version of 
a baseline

Select the baseline in the tree. On the Change Manager Object 
menu, click Show Versions. In the Versions dialog box, click 
the version you want to view, then click View.

Delete a previous version 
of a baseline

Select the baseline in the tree. On the Change Manager Object 
menu, click Show Versions. In the Versions dialog box, click 
the version you want to delete, then click Remove.

View history entries for 
baseline tasks

On the View menu, click Show History. In the History dialog 
box, view history entries for completed baseline tasks on the 
History page.

Table 2–2 Performing Comparison Operations 

Operation Steps for Performing the Operation

Create a new comparison On the Change Manager Tools menu, click Compare Database 
Objects and follow the steps in the DB Capture application.

View a comparison Select the comparison in the tree. On the Change Manager 
Object menu, click View Comparison.

Table 2–1 Performing Baseline Operations (Cont.)

Operation Steps for Performing the Operation
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For more information on working with comparisons, see:

■ "Viewing History Entries for Tasks" on page 2-8 for more information on 
viewing history entries for comparison tasks.

■ "Working With a Particular Version of a Change Plan, Baseline, or Comparison" 
on page 2-10 for more information on working with particular versions of 
comparisons.

■ "Exporting and Importing Change Plans, Baselines, and Comparisons" on 
page 2-11 for more information on exporting and importing comparisons.

Working with Change Plans
Table 2–3 describes how to use Change Manager to perform different types of 
change plan operations.

Delete a comparison Select the comparison in the tree. On the Change Manager 
Object menu, click Remove. This deletes all the versions of the 
comparison.

Export a comparison to a 
file

On the Change Manager Tools menu, click Export 
Plans/Baselines/Comparisons, then specify the comparison to 
export and the name of the export file.

Import a comparison from 
a file

On the Change Manager Tools menu, click Import 
Plans/Baselines/Comparisons, then specify the name of the 
export file and the comparison to import.

Create a new version of a 
comparison

Select the comparison in the tree. On the Change Manager 
Object menu, click Repeat Comparison.

View a previous version of 
a comparison

Select the comparison in the tree. On the Change Manager 
Object menu, click Show Versions. In the Versions dialog box, 
click the version you want to view, then click View.

Delete a previous version 
of a comparison

Select the comparison in the tree. On the Change Manager 
Object menu, click Show Versions. In the Versions dialog box, 
click the version you want to delete, then click Remove.

View history entries for 
comparison tasks

On the View menu, click Show History. In the History dialog 
box, view history entries for completed comparison tasks on 
the History page.

Table 2–2 Performing Comparison Operations (Cont.)

Operation Steps for Performing the Operation
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Table 2–3 Performing Change Plan Operations 

Operation Steps for Performing the Operation

Create a new change plan On the Object menu, click Create Change Plan. Then in the 
Create Change Plan Options dialog box, select the name of the 
application that you want to use to create the change plan (the 
Create Manually option lets you use Plan Editor to create the 
plan). See Chapter 3, "Using Plan Editor" for more information 
on using Plan Editor to create a change plan.

View and modify a change 
plan

Select the change plan in the tree. On the Object menu, click 
Edit Change Plan. This lets you view and modify the change 
plan using Plan Editor. See Chapter 3, "Using Plan Editor" for 
more information on using Plan Editor to edit and modify a 
change plan.

Delete a change plan Select the change plan in the tree. On the Object menu, click 
Remove. This deletes all versions of the change plan.

Rename a change plan Select the change plan in the tree. On the Object menu, click 
Edit Change Plan. On the General page for the plan in Plan 
Editor, edit the name of the plan, then click one of the folders 
in the Plan Editor tree. When the new plan name appears in the 
Plan Editor tree, exit Plan Editor. On the Change Manager 
View menu, click Refresh to see the plan’s new name 
displayed in the Change Manager tree.

Export a change plan to a 
file

On the Change Manager Tools menu, click Export 
Plans/Baselines/Comparisons, then specify the change plan to 
export and the name of the export file.

Import a change plan from 
a file

On the Change Manager Tools menu, click Import 
Plans/Baselines/Comparisons, then specify the name of the 
export file and the change plan to import.

Create a new version of a 
change plan

None. Oracle Change Management Pack automatically creates 
a new version of a change plan when necessary to ensure that 
the history features for the change plan work properly.

View a previous version of 
a change plan

Select the change plan in the tree. On the Change Manager 
Object menu, click Show Versions. In the Versions dialog box, 
click the version you want to view, then click View.

Delete a previous version 
of a change plan

Select the change plan in the tree. On the Change Manager 
Object menu, click Show Versions. In the Versions dialog box, 
click the version you want to delete, then click Remove.

View history entries for 
change plan tasks

On the View menu, click Show History. In the History dialog 
box, view history entries for pending plan tasks on the Pending 
page and view history entries for completed plan tasks on the 
History page.
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For more information on working with change plans, see:

■ "Viewing History Entries for Tasks" on page 2-8 for more information on 
viewing history entries for change plan tasks.

■ "Working With a Particular Version of a Change Plan, Baseline, or Comparison" 
on page 2-10 for more information on working with particular versions of 
change plans.

■ "Exporting and Importing Change Plans, Baselines, and Comparisons" on 
page 2-11 for more information on exporting and importing change plans.

Viewing History Entries for Tasks
You can view history entries that show the status of the following Oracle Change 
Management Pack tasks:

■ Script generation

■ Script execution

■ Capturing baselines

■ Performing comparisons

By viewing the history entries for pending tasks and completed tasks, you can 
determine when each Oracle Change Management Pack task was performed and its 
completion status.

To view the history entries for tasks in the current Oracle Change Management Pack 
repository, on the Change Manager View menu, choose the Show History option, 
which displays the History dialog box. The History dialog box allows you to view 
both pending tasks and completed tasks.

Viewing and Completing Pending Tasks
Click the Pending tab of the History dialog box to view pending tasks. Pending 
tasks are script executions that need to be kept or undone. See "Executing the Script 
with Plan Editor" on page 3-16 for more information on keeping or undoing the 
changes made by a change plan script.

The history entries on the Pending page of the History dialog box enable you to 
keep track of the Oracle Change Management Pack pending tasks, which need 
further attention. Each row on the Pending page is a history entry for one pending 
task.
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When you complete a pending task and refresh the History dialog box, the entry is 
moved to the History page. You also have the option of manually moving an entry 
for a pending task to the History page.

On the Pending page, you can perform the operations shown in Table 2–4:

You are notified of any pending tasks on the Pending page and are given the 
opportunity to complete them each time you exit Change Manager.

Viewing Completed Tasks
Click the History tab of the History dialog box to view completed tasks.

The history entries on the History page of the History dialog box enable you to 
track the Oracle Change Management Pack tasks that have been completed or that 
have been manually moved from the Pending page to the History page. Each row 
on the History page is a history entry for one completed task or a pending task that 
was manually moved from the Pending page. The status for a particular history 
entry tells you whether the task completed successfully or not.

Table 2–4 Operations That Can be Performed on Pending Tasks 

Operation Steps to Perform the Operation

Complete a pending task Select a pending task and click the GoTo button. On the 
Execution Log page, click Keep or Undo to keep or undo the 
changes made by the script execution.

Update the pending tasks 
display

Click the Refresh button. Any new pending tasks are 
displayed. Any previously pending tasks that have been 
completed are removed from the Pending page and displayed 
on the History page.

Manually move a pending 
task to the History page

Select a pending task and click the Move to History button. 
This moves the pending task to the History page, where you 
have the option of completing it later.

Save history entries to a 
file

Click the Save List button. The Save List dialog box lets you 
save some or all of the pending task history entries in a file. 
You have the option of viewing and printing the information to 
be included in the file before saving the file.

Sort history entries Click a column heading on the Pending page. The first time 
you click a heading, the history entries are sorted in ascending 
order, using the values in that column. If you click again on the 
same heading, the history entries are sorted in descending 
order, using the values in that column.



Working With a Particular Version of a Change Plan, Baseline, or Comparison

2-10 Getting Started with Oracle Change Management Pack

On the History page, you can perform the operations shown in Table 2–5:

Working With a Particular Version of a Change Plan, Baseline, or 
Comparison

After you create a baseline specification, you can use the specification to generate 
multiple baselines over time. Similarly, after you create a comparison specification, 
you can use it to generate multiple comparisons over time. New versions of a 
change plan are created automatically when necessary to ensure that the history 
features for change plans work properly.

By default, when you select a change plan, baseline, or comparison in Change 
Manager, any operations you perform are carried out on the latest version of that 
object. In some cases, however, you may want to view or remove an earlier version 
of the object. To do so, after you select the object in Change Manager, on the Object 
menu, click Show Versions. This displays the Versions dialog box. In the Versions 
dialog box, select the version of the object that you are interested in, then click View 
to view the selected version of the object in the appropriate Oracle Change 

Table 2–5 Operations That Can be Performed on Completed or Manually Moved 
Tasks

Operation Steps to Perform the Operation

Remove a task Select a task and click Remove.

Update the History page 
display

Click the Refresh button. Any new completed tasks are 
displayed.

View a task Select a task and click GoTo. The appropriate Oracle Change 
Management Pack window is opened in the correct context for 
viewing the task. If the selected task is a pending task that was 
manually moved to the History page, after you click GoTo, 
click Keep or Undo on the Execution Log page to keep or undo 
the changes made by the script execution.

Save history entries to a 
file

Click the Save List button. The Save List dialog box lets you 
save some or all of the task history entries in a file. You have 
the option of viewing and printing the information to be 
included in the file before saving the file.

Sort history entries Click a column heading on the History page. The first time you 
click a heading, the history entries are sorted in ascending 
order, using the values in that column. If you click again on the 
same heading, the history entries are sorted in descending 
order, using the values in that column.
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Management Pack window or click Remove to remove the selected version of the 
object from the Oracle Enterprise Manager repository.

Exporting and Importing Change Plans, Baselines, and Comparisons
You can export and import change plans, baselines, and comparisons using Change 
Manager. After you export one or more of these objects to a file, you can then 
import the objects into another repository, which copies the objects from one 
repository to another.

To export change plans, baselines, or comparisons:

1. In Change Manager, on the Tools menu, click Export 
Plans/Baselines/Comparisons.

2. In the Export Plans/Baselines/Comparisons dialog box, specify the object or 
objects to export, then click Export.

3. In the Export Plans/Baselines/Comparisons to which file? dialog box, select a 
file into which the selected objects will be exported, then click Save.

To import change plans, baselines, or comparisons:

1. In Change Manager, on the Tools menu, click Import 
Plans/Baselines/Comparisons.

2. In the Import Plans/Baselines/Comparisons from which file? dialog box, 
identify the file that contains the object or objects that you want to import, then 
click Open.

3. In the Import Plans/Baselines/Comparisons dialog box, select the object or 
objects that you want to import, then click Import. If the import utility 
discovers that any of the objects being imported has the same name as an 
existing object in the current repository, you will be prompted to either rename 
the object being imported or to cancel the import operation for that object.

Note: When you remove a version of a change plan, baseline, or 
comparison, the version numbers for the remaining versions of that 
object remain the same.
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3
Using Plan Editor

The Plan Editor application allows you to modify or reproduce (or both) database 
object definitions at one or more databases.

With Plan Editor, you create or modify a single change plan and populate it with 
change requests. To deploy the plan, you specify one or more destination databases, 
generate a script to apply the plan’s change requests at each database, then execute 
the scripts.

You can also create change plans with DB Diff’s Synchronization wizard, DB Alter, 
DB Quick Change, and DB Propagate. However, these applications differ from Plan 
Editor because each of them is designed to create a change plan with specific types 
of change requests that make specific types of changes.

Plan Editor is a more flexible change plan tool. You can use Plan Editor to create 
and modify a change plan that includes any type of change request and to  make a 
wider variety of changes.

This chapter explains in detail the steps for modifying and creating object 
definitions using Plan Editor.

Modifying and Creating Object Definitions with Plan Editor
This section describes how to start the Plan Editor application and use it to modify 
and create object definitions.
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Creating a Plan with Plan Editor
To create a new plan using Plan Editor, follow these steps:

1. Start Change Manager from the Oracle Enterprise Manager console.  On the 
Tools menu, point to Change Management Pack, then click Change Manager.

2. On the Change Manager Object menu, click Create Change Plan. In the Create 
Change Plan Options dialog box, click Manual Creation, which displays the 
Create Plan dialog box.

3. Create a plan by following these steps, which are also shown in Figure 3–1 on 
page 3-3:

a. On the General page of the Create Plan dialog box:

* Supply a unique name for the plan. Oracle Change Management Pack 
allows plan names and baseline names of up to 50 characters in length. 
Any character, including blank, is allowed. However, to avoid 
confusion, it is recommended that you do not use leading or trailing 
blanks in a plan name or baseline name.

* Choose the plan’s source database (the database used to create the 
plan’s change requests) from the list of databases.  The list of databases 
are the databases known to (discovered by) the Oracle Enterprise 
Manager console.

* Provide a description of the plan (optional).

b. Click Create to create the plan. This launches Plan Editor for the 
newly-created plan.

Note: Plan Editor provides right mouse button support for some 
operations.

After you select an object in the Plan Editor navigator, click the 
right mouse button to display a menu of options. Any menu 
options that are not appropriate for the selected object are 
unavailable from the menu.
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Figure 3–1 Creating and Modifying Object Definitions with Plan Editor

Defining Change Requests with Plan Editor
After Plan Editor creates the empty plan, you need to define one or more change 
requests to add to the plan.  Depending on what you want the plan to accomplish, 
you will define directives, exemplars, or both for the plan.

Understanding Directives
A directive is a set of changes you specify for an existing, named object definition.  
A directive can be thought of as a “Super Alter” statement.

A directive for an object definition tells an Oracle Change Management Pack 
application, “Make these specific changes to the object definition.”  Suppose, for 
example, that you are defining a directive for a table named Table_1.  Some of the 
change requests that you could specify in a directive for table Table_1 include:

■ Adding column REGION_ID with data type of NUMBER(3).

■ Renaming the column REGNAME to AREA_NAME.

■ Changing the tablespace for the table to tablespace TABLESPACE_1.

Define change requests for the plan

Generate a script for the destination

Execute the script

Create the plan

Select a destination database

View the impact and script

NU-3708A-AI
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You create a directive for an object definition by selecting an object definition to be 
modified, then specifying the changes to the object definition’s attributes on 
property sheets similar to those in DBA Studio.

A directive has the scope of a single object definition (the changes made by the 
directive are applied to a single object definition). 

It is also possible to extend the scope of a directive so that the changes specified in 
the directive are applied to multiple object definitions that you specify. A directive 
with an extended scope is called a scoped directive. Use a scoped directive to make 
the same set of changes to more than one object definition.

Change plans created with the following applications contain only directives:

■ DB Alter (directives and scoped directives can be created)

■ DB Quick Change (directives can be created, but scoped directives cannot be 
created)

Change plans created with Plan Editor can contain directives, scoped directives, 
and exemplars (or any combination of these types of change requests).

Understanding Exemplars
An exemplar is a complete object definition to be reproduced, either by creating a 
new object definition or by modifying an existing object definition of the same name 
and object type.  An exemplar can be thought of as the example of what you want to 
reproduce.

An exemplar tells an Oracle Change Management Pack application, “Reproduce 
this object definition.  If an object definition of the same name and type already 
exists, make whatever changes are necessary to that object definition so that it 
matches this object definition.  If the object definition does not exist, create an object 
definition that matches this object definition.”  When you define an exemplar, you 
can also include grants information for the exemplar.

Change plans created with the following applications contain only exemplars:

■ DB Propagate

■ DB Diff’s Synchronization wizard

Change plans created with Plan Editor can contain exemplars, directives, and 
scoped directives (or any combination of these types of change requests).
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Table 3–1  on page 3-5 summarizes the types of change requests that can be created 
with Oracle Change Management Pack applications.

Some Oracle Change Management Pack applications (such as DB Alter and DB 
Propagate) make it evident when you are creating change requests because these 
applications prompt you to add directives or exemplars to the change plan.  Other 
applications (such as DB Diff’s Synchronization wizard and DB Quick Change) 
prompt you to select object definitions to copy or modify, but do not make it 
evident that the selected definitions are directives or exemplars that are being 
added to the change plan. DB Search does not create change requests.

Defining a Directive with Plan Editor
To specify the  modifications to be made to an existing object definition at the 
destination database, follow these steps to define a directive for that object 
definition in the source database:

1. On the Plan Editor Plan menu, click New Change Requests.

2. Expand the Source Database tree in the New Change Requests dialog box, then 
select one or more object definitions for which you want to create directives.  
Definitions that are already in the plan are shown in gray and cannot be 
selected.

3. Click the Directive button. Each selected object definition in the Source 
Database tree turns gray when the directive for the object definition is created. 
This step also causes the selected directives to be displayed in the Change Plan 
tree.

4. Click Close or leave the New Change Requests dialog box displayed.

Table 3–1 Change Requests Created with Oracle Change Management Pack 
Applications

Application Type of Change Requests Created

DB Alter directives and scoped directives

DB Diff Synchronization wizard exemplars

DB Propagate exemplars

DB Quick Change directives

Plan Editor directives, scoped directives, and 
exemplars

DB Search None



Modifying and Creating Object Definitions with Plan Editor

3-6 Getting Started with Oracle Change Management Pack

5. In the Plan Editor tree, expand the Change Requests folder under the new plan 
to display folders for each object type for which change requests have been 
defined.

6. Expand an object type folder to view the change requests that have been 
defined for that object type. Directives are marked with both the directive icon 
and an object type icon. The directive icon appears first, followed by the object 
type icon, then the name of the object. The directive icon is shown in Figure 3–2.

7. Click the name of a directive in the Plan Editor tree. This displays the General 
page for the directive in Plan Editor’s detail view.

8. On the General page, click the Edit Directive button. This displays the Edit  
dialog box for the directive. Property sheets for the object are displayed in the 
Edit dialog box. You use the property pages for the directive to specify the 
changes that you want to make to the directive object definition.

9. On the property pages, specify the changes you want to make to the object 
definition. Click OK to accept the changes you have specified.

Figure 3–2 The Directive Icon

Note that a directive describes the changes you want to make to an object definition.  
Therefore, the meaningful part of a directive is the changes that you have specified.  
You can view these changes by clicking the directive in the Plan Editor tree and 
viewing the list of changes on the General page for the object. After you have 
created a directive for an object, you can make further edits to the directive if the 
object still exists in the change plan’s source database.  When you make further 
edits to a directive, the object’s definition is loaded from the source database, and 
the edits already specified in the directive are applied to the object.

Defining a Scoped Directive with Plan Editor
By default, a directive contains the changes to be applied to a single object 
definition. However, it is possible to extend the scope of a directive so that the 
changes specified in the directive are applied to multiple object definitions that you 
specify. A directive with an extended scope is called a scoped directive.

Scoped directives can be very powerful. For example, suppose that you want to 
move several tables to a new tablespace without creating a separate directive for 
each table you want to move. Instead, you can create a directive for one of the 
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tables, and in that directive specify the name of the new tablespace for the table. 
Then you can edit the scope specification for that directive, making sure that the 
search criteria identifies the other tables that you want to move to the new 
tablespace. When the script is generated, the scoped directive’s instructions are 
applied to each object that matches the search criteria. When the script executes, it 
carries out the scoped directive’s instructions on each matched object. In this 
example, all the tables that match the scope directive’s search criteria are moved to 
the new tablespace that is specified in the scoped directive.

To create a scoped directive, follow these steps:

1. In the Plan Editor tree, click the directive for which you want to edit the scope 
specification. If you have not already specified the set of changes that you want 
the directive to apply, click the Edit Directive button on the General page for 
the directive and specify those changes, as described in "Defining a Directive 
with Plan Editor" on page 3-5.

2. On the General page for the directive, click the Edit Scope button.

3. In the Edit Directive Scope dialog box, specify a set of search criteria to identify 
the database object definitions to which the changes specified in the scoped 
directive will be applied.

The Edit Directive Scope dialog box contains the following fields:

■ Object Type

Displays the object type of the directive object. This field is non-editable. 

■ Schemas

If the directive object is a non-schema object, you cannot modify this field.

If the directive object is a schema object, you can modify this field. To 
include any schema name in the search criteria, click Any Schema. To 
include any schema name except the SYS and SYSTEM schemas, click 
Exclude SYS, SYSTEM after clicking Any Schema.

To include specified schemas or wild card patterns in the search criteria, 
click Add. The Select Schemas dialog box is displayed. Use the Select 
Schemas dialog box to add specified schemas or wild card patterns to the 
search criteria. If you specify wild card patterns, any schema name that 
matches the pattern will be included in the search criteria.

To remove specified schemas or wild card patterns from the search criteria, 
select the item in the Schemas list, then click Remove.

■ Search For
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To include any object name in the search criteria, click Any Object Name. 

To include specified object names or wild card patterns in the search 
criteria, click Specified Object Names and then click Add. The Select 
Names dialog box is displayed. Use the Select Names dialog box to add 
specified object names or wild card patterns to the search criteria. If you 
specify wild card patterns, any object name that matches the pattern will be 
included in the search criteria.

To remove specified schema names or wild card patterns from the search 
criteria, select the item in the Search For list, then click Remove.

4. Click OK to confirm the search criteria for the scoped directive. A Scope 
Specification box that includes the search criteria that you chose appears on the 
General page for the directive. Also, in the Plan Editor tree, the directive icon 
changes to the scoped directive icon.

Scoped directives are marked with both the scoped directive icon and an object type 
icon.  The scoped directive icon appears first, followed by the object type icon, then 
the name of the object. The scoped directive icon is shown in Figure 3–3.

Figure 3–3 The Scoped Directive Icon

A change plan can have only one change request for an object in a destination 
database. For example, a plan cannot contain both a directive and a scoped directive 
for the same object in a destination database. If a change plan contains multiple 
change requests for the same object, this problem will be identified in the impact 
report.

Refer to the online help for more information on scoped directives.

Defining an Exemplar with Plan Editor
To reproduce an existing object definition at a destination database, you create an 
exemplar for that object definition in the source database.  Later, when the script 
generated from the change plan is executed against the destination database, one of 
the following three actions is performed for each exemplar in the change plan:

■ If an object definition of the same name and type as the exemplar does not exist 
at the destination database, the script creates the object at the destination 
database.
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■ If an object definition of the same name and type as the exemplar exists at the 
destination database but the object definition is different than the exemplar’s 
definition, the script makes the necessary changes to the object definition so that 
it matches the exemplar’s definition.

■ If an object definition of the same name and type as the exemplar exists at the 
destination database and the object definition exactly matches the exemplar’s 
definition, no changes are made to the object definition at the destination 
database.

To reproduce an existing object definition at a destination database, follow these 
steps to create an exemplar for that object definition in the source database:

1. On the Plan Editor Plan menu, click New Change Requests.

2. Expand the Source Database tree in the New Change Requests dialog box, then 
select one or more object definitions for which you want to create exemplars.  
Definitions that are already in the plan are shown in gray and cannot be 
selected.

3. Click the Exemplar button. Each selected object definition in the Source 
Database tree turns gray when the exemplar for the object definition is created. 
This step also causes the selected exemplars to be displayed in the Change Plan 
tree.

4. Click Close or leave the New Change Requests dialog box displayed.

5. In the Plan Editor tree, expand the Change Requests folder under the new plan, 
which displays folders for each object type for which change requests have been 
defined.

6. Expand an object type folder to view the change requests that have been 
defined for that object type.  Exemplars are marked with both an object type 
icon and with the exemplar icon.  The exemplar icon appears first, followed by 
the object type icon, then the name of the object. The exemplar icon is shown in 
Figure 3–4.

Figure 3–4 The Exemplar Icon
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7. To view the attributes for an exemplar, expand the exemplar and click its 
Attributes subobject. This displays the object definition’s property pages in Plan 
Editor’s detail view. You cannot modify the exemplar’s attributes.

8. To view the grants associated with an exemplar, expand the exemplar and click 
its Grants subobject (note that the Grants subobject is not displayed for object 
types that do not participate in grants).  This displays the object definition’s 
Grants property page in Plan Editor’s detail view.  By default, when you 
include an exemplar in a plan, all the grants associated with the exemplar object 
are included in the plan, which means when the object definition is reproduced 
at a destination database, the object’s grants are reproduced, if possible.  A 
grant will be applied if the objects that reference the grant already exist or will 
be created at the destination database when the change plan's script is executed 
at the destination database.

Select one or more of an exemplar’s grants and click the Exclude button to 
exclude those grants from the plan. If you decide later that you want to include 
one or more excluded grants for an exemplar in the plan, select those grants, 
then click the Include button to include them in the plan.

After you include a specific grant for an exemplar in a plan, it is possible for the 
same grant to be modified in the database.  In this case, the Refresh button 
becomes available when you select that grant on the Grants page.  If you want 
to update the grant in the plan to match the grant in the database, select the 
grant, then click the Refresh button.

If no grants are associated with the exemplar, the Grants page does not display 
any grants.

9. To view the dependencies and dependents of an exemplar, expand the exemplar 
and click its Dependencies subobject.  This displays the Dependencies and 
Dependents property pages for the exemplar.

The Dependencies page displays the objects that the exemplar depends on.  
Each dependency object definition on the Dependencies page should be added 
to the plan, except for those object definitions that already exist at the 
destination database.  For example, suppose you add an exemplar for a trigger 
to a plan, and the trigger refers to a table that is not in the plan and which does 
not exist at the destination database.  In this case, you should manually add an 
exemplar for the referenced table to the plan, otherwise the trigger cannot be 
created at the destination database. To manually add a dependent object to the 
plan, select the object definition and click Add to Plan. Objects that are already 
in the plan are unavailable.
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The Dependents page displays the objects that depend on the exemplar.  You 
can use this page to locate other object definitions that are related to the 
exemplar, and, if you wish, manually add them to the plan. To manually add a 
dependency object definition to the plan, select the object definition and click 
Add to Plan. Objects that are already in the plan are unavailable.

10. You can view and, if desired, change the value of one or more of the plan’s 
propagate options.  To do so, click on the plan name in the Plan Editor tree.  In 
the detail view, click the Propagate Options tab to view and, if desired, modify 
one or more values for the plan’s propagate options.  The values of the 
propagate options for a change plan determine how exemplars in the plan are 
applied when a script generated from the plan is run at a destination database.

If your plan contains table exemplars, you can reproduce both the table 
definitions for the exemplars and the data associated with the table definitions 
at a destination database. To do so, select the Copy Table Data option. If you 
want to reproduce only the definitions for the table exemplars, do not select the 
Copy Table Data option.

See the online help for a complete list of the propagate options and a 
description of how their values affect the application of a change plan’s 
exemplars at a destination database.

Selecting a Destination Database with Plan Editor
To select the destination database where you want the plan to be executed:

1. On the Plan Editor Plan menu, click New Destination.

2. On the General page of the Create Destination dialog box, select a destination 
database from the list of available destinations, and, optionally, supply a 
description for the database.

3. Click Create.

Understanding Script Generation
After a destination database has been selected, a script can be generated from the 
change plan. The script generated from the change plan (not the plan itself) will be 
run against the destination database.  During the initial stage of script generation, 
Oracle Change Management Pack examines the structure and definitions in the 
destination database so that it can generate a script designed exclusively for 
execution against the destination database.
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When you use a single plan to generate scripts for several databases that have 
different structures and definitions, Oracle Change Management Pack generates a 
different script for each database.  This is because Oracle Change Management Pack 
takes each destination database’s structure and definitions into account when 
generating the script.

For example, suppose your plan contains an exemplar for table Table_2, and you 
use Oracle Change Management Pack application to generate two scripts, one to 
run against destination database DB_1 and the other to run against destination 
database DB_2.  If table Table_2 does not exist in database DB_1, the script 
generated for DB_1 will include statements that define table Table_2.  If a different 
version of table Table_2 already exists in database DB_2, the script generated for 
DB_2 will include statements to make the definition of table Table_2 in database 
DB_2 match the exemplar for table Table_2.

After Oracle Change Management Pack generates a script for a destination 
database, you can view and, optionally, edit the script.  Oracle Change Management 
Pack also creates an impact report when it generates the script.  You should view 
the impact report to determine the impact of executing the script at the destination 
database.  The impact report provides a summary of the number and types of 
objects that will be modified when the script executes at the destination database.  
The impact report also shows warnings and errors, including a description of the 
requested operations that cannot be performed at the destination database, for 
example, a request to drop a column that no longer exists at the destination 
database.

If you modify a plan’s change requests after you have generated one or more scripts 
for the plan, Oracle Change Management Pack considers the scripts that have been 
generated to be obsolete scripts.  When you try to execute an obsolete script, Oracle 
Change Management Pack displays a message that advises you that the plan was 
modified after the script was generated and confirms whether you want to execute 
the script anyway.  It is prudent to generate a new script from the modified plan 
instead of executing an obsolete script.

Generating a Script with Plan Editor
To generate a script for the destination database:

1. Under the Destinations folder, expand the destination database.

2. Click the Script subobject.  This displays the script property pages in the detail 
view.
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3. On the Options page, you can map schemas in the source database to their 
corresponding schemas in the destination database. By default, change requests 
specified for database objects in a source schema are applied to a destination 
schema with the same name. You only need to map schemas when you want 
change requests for the object definitions in a schema in the source database to 
be applied to a destination schema with a different name. For example, if your 
plan includes change requests created for the SALES table in the FINANCE 
schema and you want to apply those changes to the SALES table in the 
FINANCE_V2 schema, then you need to map the FINANCE schema to the 
FINANCE_V2 schema. To map two schemas, select the source schema from the 
source database list and select the destination schema from the destination 
database list, then click the Down arrow.

You can also specify a scratch tablespace that Oracle Change Management Pack 
can use for script operations that require temporary storage of data. For 
example, renaming a tablespace requires a scratch tablespace because all the 
data in the tablespace must be stored temporarily while the first tablespace is 
dropped and recreated. Other operations, such as operations on a table, require 
either enough storage space in the table’s tablespace for two copies of the 
original table or a scratch tablespace to contain the table copy. 

4. Click the Generate button to generate the script for the destination database.  
Work-in-progress messages display while the script is being generated.

Figure 3–5 shows a fully expanded change plan in Plan Editor with the Script 
subobject selected.
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Figure 3–5 A Fully Expanded Change Plan

Viewing the Impact Report and Script Summary with Plan Editor
Oracle Change Management Pack creates an impact report when it generates the 
script.  You should view the impact report to determine the impact of executing the 
script at the destination database.  The impact report provides a summary of the 
number and types of objects that will be modified when the script executes at the 
destination database.  The impact report also shows warnings and errors, including 
a description of the requested operations that cannot be performed at the 
destination database, for example, a request to drop a column that no longer exists 
at the destination database.

After generating the script, you should view the impact report and script summary. 
You can also edit the script.
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■ To determine the impact of executing the generated script at the destination 
database, examine the impact report on the Impact Report page. The impact 
report provides errors and warnings, including a description of the requested 
operations that cannot be performed at the destination database, for example, a 
request to rename a table that no longer exists at the destination database. The 
impact report also provides a summary of the number and types of objects that 
will be modified when the script executes at the destination database.

Script errors must be fixed. Evaluate the errors, take corrective action, then 
regenerate the script.

Script warnings should be read and the appropriate action taken before you 
attempt to execute the script.  Some warnings are informational, for example, a 
message that dropping a column will cause an index to be dropped, as shown 
in Figure 3–5. To save the impact report to a file, click the Save As button.

■ Examine a summary of the script on the Script Summary page.  The script 
summary contains the SQL statements and non-SQL operations that will be 
executed at the destination database to implement the plan’s change requests.  
The actual script includes both the SQL statements from the script and OraTCL 
statements.  To save the script summary to a file, click the Save As button.

■ To edit the actual script (not the script summary), click the Edit script button on 
the Script Summary page.  Note that the actual script can be very difficult to 
understand, and editing it may result in undesired changes that you cannot 
undo after the script is executed. To save the script to a file, click the Save As 
button.

Note that scripts produced by Oracle Change Management Pack applications 
can only be run using Oracle Change Management Pack applications, the 
Oracle Change Management Pack command line interface, or the Oracle 
Enterprise Manager job system. See "execute command" on page A-5 for more 
information about executing a script using the command line interface. See the 
online help for more information about executing a script using the job system.

A script that has been edited can be executed even if it has script generation errors.

If the impact report or the script summary is unacceptable, you can take one or 
more of the following actions:

■ Modify the plan by modifying the directives, exemplars, propagate options, (or 
all of these), then save the plan, and generate a new script.

■ Modify the destination database (add, modify, or delete object definitions, for 
example), then generate a new script.
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■ Change the schema mappings on the Options page, then generate a new script.

■ Edit the script, then execute the script. To edit a script, click Edit script on the 
Script page. Note that the actual script can be very difficult to understand, and 
editing it may result in undesired changes that you cannot undo after the script 
is executed.

Understanding Script Execution
To ensure that you can undo the execution of a script, Oracle Change Management 
Pack makes a copy of the old data when needed for recovery purposes. The 
recovery data is stored in temporary tables that look like the original tables but have 
different names.

Oracle Change Management Pack allows you to keep or undo the changes made 
when a script is executed.

If you keep the changes, the temporary tables used by the recovery script are 
deleted, making the changes permanent.

If you undo the changes, the recovery script uses the recovery data to return the 
user tables and data to their original state.

Executing the Script with Plan Editor
To execute the script against the destination database:

1. Expand the destination database and select the Run subobject in the Plan Editor 
tree.

2. On the Execution Log page, click Execute to run the script immediately.

3. You can examine the execution log on the Execution Log page during or after 
script execution.  The execution log displays messages, including the status of 
the script execution ("Script execution succeeded" or "Script execution failed").  
To save the execution log to a file, click the Save As button.

4. You can keep or undo the changes made by the script to object definitions at the 
destination database:

– When you click Keep, Plan Editor deletes temporary tables used by the 
recovery script, making the changes at the destination database permanent.

– When you click Undo, Plan Editor uses the recovery script to undo the 
changes made at the destination database.
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If you want to execute the plan’s change requests against a different destination 
database, select a new destination database, then generate, view, and execute a new 
script against the database.

You can also execute an Oracle Change Management Pack script using:

■ The Oracle Enterprise Manager job system. See the online help for more 
information.

Note: There are a small number of attribute changes for which 
undo operations are not present in the recovery script.  The 
common characteristics of these cases is that the original change 
can be done in a single ALTER statement and the undo operation 
requires multiple steps.  In all cases where an undo operation is not 
included in the recovery script:

■ You are clearly warned, both in the impact report and if you 
execute the recovery script.

■ You can still use Oracle Change Management Pack to perform 
the undo operation, but you must do this as a separate step.

Suppose, for example, that a change plan makes several changes, 
including adding a column to a table.  The impact report warns you 
that the recovery script will not drop the added column.  (Note that 
the other changes can be undone.)  If you execute the recovery 
script, you are warned again that the added column was not 
dropped. You can then use another Oracle Change Management 
Pack application (such as DB Quick Change) to drop the column as 
a separate step.

The attribute changes for which undo operations are not present in 
the recovery script are:

■ adding a column to a table

■ modifying a column’s datatype to specify a larger size for the 
column

■ adding a datafile to a tablespace

■ specifying a date for the Start Date or Next Date fields for a 
snapshot
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■ The Oracle Change Management Pack command line interface. See "execute 
command" on page A-5 for more information.

Dealing with Script Execution Errors
The two main causes of script execution errors are:

1. Stale scripts

When the Oracle Change Management Pack translator generates a script for a 
destination database, it takes the current structure of the database into account.  
If objects at the destination database are deleted or modified after the script is 
generated, the script is considered to be a stale script.  Errors can occur during 
the execution of a stale script or recovery script.  For example, if a particular 
user is removed from a destination database before you run a script, the 
execution log may display an error message such as this after the statement that 
generated the error message:

ORA-01918: user ‘GEORGE’ does not exist
2. Errors that the Oracle Change Management Pack translator does not anticipate 

when it generates a script, for example, insufficient space in a tablespace to 
carry out the requested changes. If you suspect that a script execution error is 
caused by a problem with the Oracle Change Management Pack translator, 
please contact Oracle Worldwide Customer Support.

To have Oracle Change Management Pack predict script execution failures (the 
default), enable the OCM_FAILURE_PREDICTION property in the ocm.properties 
file. The property is enabled when its value is set to "true" (case insensitive) or when 
the property does not exist in your ocm.properties file. When failure prediction is 
enabled, Oracle Change Management Pack performs resource checking (for 
example, it checks for sufficient space and quota to make copies of tables or to move 
items from one tablespace to another) during script generation. Resource warnings 
are reported in the impact report. Script generation takes longer when failure 
prediction is enabled.

If the property is present and has a value other than "true," then resource checking 
and script failure prediction does not occur.

When error messages occur during script execution, the best ways to fix the 
problem are:

■ Click the Undo button to undo the changes. Then, regenerate the script.

■ Correct the error at the destination database (for example, by creating a user 
again or by increasing the size of a tablespace), then click Continue to continue 
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executing the script.  If you specify a scratch tablespace, you must generate a 
new script and execute the new script.

■ Edit the script and click Continue to continue executing the script.  This is the 
least preferable option, because editing the script  may result in undesired 
changes that are not reversed when you press Undo.

When error messages occur during recovery script execution, the best ways to fix 
the problem (in order of preference) are:

1. Correct the error at the destination database (for example, by creating the user 
again), then click Undo to continue executing the recovery script.

2. Edit the recovery script, then click Undo to continue executing the recovery 
script.
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A
Command Line Interface Appendix

Oracle Change Management Pack provides a command line interface that is 
available on Windows NT. This appendix provides the following sections that 
provide more information about the command line interface:

■ "Possible Uses for the Command Line Interface" on page A-1

■ "Understanding the Notation Used for the Command Syntax" on page A-2

■ "Requirements for Using the Command Line Interface" on page A-2

■ "Using the Command Line Interface Commands" on page A-3

■ "Status Codes Returned by the Command Line Interface" on page A-8

Possible Uses for the Command Line Interface
You can use the Oracle Change Management Pack command line interface to 
perform various Change Management Pack tasks without accessing the Change 
Management Pack graphical user interface. Some of the tasks that you can perform 
using the command line interface include:

■ Capturing the definitions of a set of database objects each night, using the same 
baseline specification

■ Comparing the definitions of a set of database objects to those of a different 
schema or database, or a baseline, each night

■ Generating scripts during off hours by applying a single plan to each of a set of 
destination databases, and then executing the script at each destination if the 
generation completes without error
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Understanding the Notation Used for the Command Syntax
The reference sections that describe each command in the Oracle Change 
Management Pack’s command line interface use the following notation to describe 
command syntax:

Square brackets [...] denote optional elements.

Braces {...} denote a required element which can be one of two or more options 
separated by vertical bars |.

Square brackets enclosing options separated by vertical bars indicate an optional 
element consisting of one of the options.

Italics denote elements to be substituted by the user, or elements that are further 
defined elsewhere.

All other characters are keywords and punctuation that should be typed as shown 
in the command descriptions.

The commands and keywords are not case-sensitive.

Requirements for Using the Command Line Interface
When you enter the command line interface commands interactively at the MS-DOS 
prompt, preface each command with the ocm keyword, for example:

ocm command-name

When you use the command line interface, replace command-name with the name of 
a command line interface command.

You can enter the command line interface commands in a .BAT file. You can then 
parameterize the .BAT file and run it at specified times and/or intervals using 
operating system facilities. The commands return a status code, which allows flow- 
of-control within the containing .BAT file. If you are entering the commands in a 
.BAT file, use the MS-DOS call command to preface calls to the command line 
interface commands, for example:

call ocm command-name

The commands and keywords are not case-sensitive. The names of change plans, 
baselines, and comparisons are case- sensitive.

The Oracle Management Server (OMS) must be running when you use the 
command line interface.



Using the Command Line Interface Commands

Command Line Interface Appendix A-3

Using the Command Line Interface Commands
Table A–1 lists each command line interface command and provides a brief 
description of the command’s function:

login command
The login command establishes administrator credentials to use during a command 
line interface session. You can use the login command to establish or change 
credentials during the session. If you have not established credentials and identity, 
subsequent commands will fail.

The syntax for the command is:

ocm login OMS-connect-string

The OMS-connect-string identifies an Oracle Enterprise Manager administrator. It 
consists of an Oracle Enterprise Manager administrator’s name, the password for 
the administrator, and the name of the node on which the Oracle Management 
Server is running. For example:

Table A–1 Overview of Command Line Interface Commands

Command Use of the Command For More Information

login Establishes the administrator 
credentials to use during a command 
line interface session.

See "login command" on 
page A-3

logout De-establishes the administrator 
credentials established with the 
previous login command.

See "logout command" on 
page A-4

capture Captures a new baseline for an 
existing baseline specification.

See "capture command" on 
page A-4

compare Compares databases, baselines, or a 
baseline and a database using an 
existing comparison specification.

See "compare command" 
on page A-4

generate Generates a script from a change 
plan.

See "generate command" 
on page A-5

execute Executes a script, undoes changes 
made by a previously-executed 
script, or cleans up after the 
successful execution of a script.

See "execute command" on 
page A-5
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ocm login sysman/manager@oemadmin-pc

This command sets the Oracle Management Server (OMS) credentials in the user’s 
environment that are used until one of the following occurs:

■ The user terminates the operating system session

■ The user issues another ocm login command

■ The user issues an ocm logout command

logout command
The logout command de-establishes the administrator credentials established with 
the previous login command. Commands issued following logout will fail.

The syntax for the command is:

ocm logout

capture command
The capture command captures a new baseline for an existing baseline specification.

The syntax for this command is:

ocm capture baseline-specification-name

The baseline-specification-name must be the name of an existing baseline specification 
that was previously created using the Oracle Change Management Pack graphical 
user interface. The baseline specification name is case-sensitive. Enclose the 
baseline-specification-name within double quotation marks if it contains special 
characters, for example:

ocm capture "Baseline Specification Name With Spaces"

compare command
The compare command compares databases and/or baselines using an existing 
comparison specification.

The syntax for this command is:

ocm compare comparison-specification-name



Using the Command Line Interface Commands

Command Line Interface Appendix A-5

Each comparison specification has a series of comparisons associated with it; the 
compare command creates another comparison in the series. The 
comparison-specification-name must be the name of an existing comparison 
specification that was previously previously created using the Oracle Change 
Management Pack graphical user interface. The comparison-specification-name is 
case-sensitive. Enclose the comparison-specification-name within double quotation 
marks if it contains special characters, for example:

ocm compare "Comparison Specification Name With Spaces"

generate command
The generate command generates a script. Generation is the process of applying the 
change requests in a plan to a destination database, producing a script that will 
carry out the change requests. Another possible output of the process is a non- 
success status code indicating some level of problem with the generation process.

The syntax for this command is:

ocm generate plan destination-database

The plan and destination-database pair identifies the deployment. This deployment 
(plan and destination database) must have been already created using the Change 
Management Pack graphical user interface. The plan is case-sensitive. The 
destination-database is not case-sensitive, but it must match the name of the 
destination database as it appears in the Oracle Change Management Pack 
graphical user interface.

Enclose the plan name within double quotation marks if it contains special 
characters, for example:

ocm generate "Plan Name With Spaces" personnel_db

execute command
The execute command executes a script, undoes a previously-executed script, or 
cleans up after the successful execution of a script. The script must be in an 
appropriate state for the requested operation or the command will fail.

The syntax for this command is:

ocm execute plan destination-database
       [ [ -d  {forward|backward|cleanup} ]



Using the Command Line Interface Commands

A-6 Getting Started with Oracle Change Management Pack

       [ -s {cleanup|exit} ]
       [ -e {undo|exit} ] ]

The plan and destination-database pair identifies the deployment. This deployment 
(plan and destination database) must have been already created using the Change 
Management Pack graphical user interface. The plan is case-sensitive. If the plan 
name contains special characters, enclose it within double quotation marks. The 
destination-database is not case-sensitive, but it must match the name of the 
destination database as it appears in the Oracle Change Management Pack 
graphical user interface.

Specifying the Direction in Which to Execute the Script
Use the -d option to specify the direction in which the script should be executed or 
to specify that you want to clean up after the successful execution of the script. The 
-d options are:

■ forward

The forward option executes the script.

■ backward

The backward option executes the recovery script that undoes the changes 
made by the script. Use this option if the script failed or you do not like the 
changes made by the script. Using this option is equivalent to selecting the 
Undo option in the Change Management Pack graphical user interface after 
executing a script.

■ cleanup

The cleanup option keeps the changes made by the script and removes the 
temporary data that the recovery script uses to undo changes made by the 
script. Use this option only after the script has successfully executed in the 
forward direction. Using this option is equivalent to selecting the Keep option 
in the Change Management Pack graphical user interface after executing a 
script. After using this option, you cannot use the backward option.

By default, the script is executed in the forward direction (from the start or from the 
last successfully completed step, as applicable).

Specifying Completion Actions for a Script Execution
The -s and -e options are used to specify completion actions.
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Use the -s option to specify the action to be taken if the script executes successfully. 
The cleanup option only makes sense when the script is executed in the forward 
direction.

Use the -e option to specify the action to be taken if errors occur when the script 
executes. The undo option only makes sense when the script is executed in the 
forward direction. The default action is to exit on success or error.

Examples of Using the Execute Command
For example, to execute a script in the forward direction, keeping the changes if the 
execution completes successfully and undoing the changes if the execution fails, 
you would use a command like the following:

ocm execute plan15 corporate.world
       -d forward
       -s cleanup
       -e undo

To execute a script in the forward direction, undoing the changes if there is an error 
and simply exiting otherwise, you would use a command like the following:

ocm execute plan15 corporate.world
       -e undo

To keep the changes made by a script that has already executed successfully in the 
forward direction, use a command like the following:

ocm execute plan15 corporate.world
       -d cleanup

You can also execute a script in the backward direction, which undoes the changes 
made a script that has been executed in the forward direction. The backward option 
works only if the script was previously executed in the forward direction, either to 
completion or to a point of failure. To do this, use a command like the following:

ocm execute update_plan my_database.world
       -d backward

Enclose the plan name within double quotation marks if it contains special 
characters, for example:

ocm execute "Plan Name With Spaces" personnel_db
       -d forward
       -s cleanup
       -e undo
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Status Codes Returned by the Command Line Interface
After you execute each command line interface command, the command line 
interface returns an exit status code for the command that you entered.

Table A–2 shows the meaning of each exit status value that can be returned.

Table A–2 Exit Status Codes Returned by the Command Line Interface

Exit Status Description

0 Operation completed successfully.

1 Syntax error in command line.

2 The Oracle Management Server specified in the login 
command does not exist or the Oracle Management 
Server is not running.

3 There was an error when trying to login to the Oracle 
Management Server. Make sure that you specify correct 
credentials for the Oracle Management Server in the 
login command.

4 General, catchall error.

5 The baseline specified does not exist.

6 The comparison specified does not exist.

7 The change plan specified does not exist.

8 The script for that plan and database is already 
executing.

9 An error occurred during execution of the script.

10 Generation completed. Impact log contains warnings.

11 Generation completed. Impact log contains errors.

12 Generation failed. No script generated.

13 A problem occurred with the target database. For 
example, it does not exist.

14 Preferred credentials are not defined for the target 
database. Use the Oracle Enterprise Manager console to 
set preferred credentials for the database, then retry the 
operation.
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To obtain more information about an error or warning status code returned after a 
generate or execute command, use the Change Management Pack graphical user 
interface to view the impact log or execution log.

15 You must use the login command to specify credentials 
for the Oracle Management Server before you can issue 
other command line interface commands.

Table A–2 Exit Status Codes Returned by the Command Line Interface

Exit Status Description
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B
Troubleshooting Appendix

This appendix describes different ways of troubleshooting problems that may occur 
when you are using Oracle Change Management Pack applications.

You may decide to contact an Oracle Worldwide Customer Support representative 
regarding a problem with Oracle Change Management Pack. If so, you may be 
asked to use one of the approaches described in this appendix to obtain information 
that will help the representative determine the source of the problem.

Using Environment Variables When Running Change Manager from the 
Command Line

You can set environment variables in the MS-DOS command line before you run the 
Change Manager application from the command line. The following environment 
variables may provide information that is useful for troubleshooting and debugging 
Oracle Change Management Pack problems:

■ set ORACLE_OEM_JAVAMX=-mx<number>m

The default is -mx128m. This environment variable specifies the maximum 
amount of virtual memory to be used by the Java Virtual Machine (in 
megabytes). This memory is not used unless needed. If the amount is exceeded, 
execution will be terminated. This environment variable can be used to increase 
the amount of memory for large script generations and other purposes.

■ set ORACLE_OEM_CLIENTTRACE=<any text>

This environment variable causes an MS-DOS window to be displayed. 
Sometimes, useful troubleshooting information will be displayed in this 
window. Note that you must type some text after the equal sign for this 
environment variable to work properly. The environment variable works 
properly as long as you enter some text.
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■ set ORACLE_OEM_JAVARUNTIME=<directory where bin\java.exe is located>

You can specify this environment variable if you have a Java development 
environment. This environment variable can be useful when the system is 
hanging and you want to get a thread dump.

You can run the Change Manager application from the MS-DOS command line. To 
do so:

1. From the Windows Start menu, point to Programs, then click Command Prompt 
to display an MS-DOS window.

2. Set the working directory to the bin subdirectory of the Oracle installation 
directory (ORACLE_HOME) for Oracle Enterprise Manager, for example: 
\OEM_21\bin.

3. Start the Oracle Management Server if it is not already started, or make sure 
your system has access to an Oracle Management Server running on a different 
system.

4. Run the Change Manager application by typing the following in the MS-DOS 
window:

oemapp ocm

5. After Change Manager starts, you can start any of the other Oracle Change 
Management Pack applications from Change Manager in the usual manner.

Enabling Tracing and Debugging for Oracle Change Management Pack
You can turn on tracing and debugging facilities for the Oracle Change 
Management Pack applications to help troubleshoot problems.

The ocm.properties file in the ORACLE_HOME\sysman\ocm\bin directory for 
Oracle Enterprise Manager contains a number of properties that you can set to 
provide more information about Oracle Change Management Pack applications. 
Table B–1 displays the properties and a description of each property. 

Note: The OCM_TRACE property described in Table B–1 must be 
set to true for the troubleshooting information to be displayed in 
the MS-DOS window.
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Note: The other properties in the ocm.properties file whose names 
begin with OCM_TRACE are meaningful only when the OCM_
TRACE property is set to true.

Table B–1 Using the ocm.properties File to Enable Tracing and Debugging 

Property Description

OCM_TRACE If true, enables output of informational and problem 
trace messages.

OCM_TRACE_FILE If true, enables output of trace information to a file. 
The setting of the OCM_TRACE_VERSIONING 
property determines the name of the trace file.

OCM_TRACE_VERSIONING The OCM_TRACE_FILE property must be true for the 
OCM_TRACE_VERSIONING property to be 
meaningful.

If the OCM_TRACE_VERSIONING property is true, a 
new version of the trace file is created for each run of 
the application. The file has a name of the format 
Oracle Change Manager_nnnnnn.log.

If an Oracle Change Management Pack application is 
running in more than one session on your machine, 
examine the timestamp of each trace file to determine 
the trace file that is associated with each session. The 
trace file with the earliest timestamp is the trace file 
for the session that started first, and so on.

If the OCM_TRACE_VERSIONING property is false, 
the trace file has the name Oracle Change 
Manager.log, and the file is overwritten for each run 
of the application.

OCM_TRACE_DEBUG If the OCM_TRACE_DEBUG property is true, general 
debugging information (such as property values) is 
output to the trace file at application startup time.

OCM_TRACE_DEBUG_VERBOSE If the OCM_TRACE_DEBUG_VERBOSE property is 
true, more detailed debugging information, including 
class names and line numbers, is output to the trace 
file at application startup time.

VDB_DEBUG If the VDB_DEBUG property is true, database calls 
are output to the trace file.
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By default, the trace files for Oracle Change Management Pack applications are 
written to the ORACLE_HOME\sysman\log directory for Oracle Enterprise 
Manager.

VDB_VERBOSE_DEBUG If the VDB_VERBOSE_DEBUG property is true, more 
detailed information about database calls, including 
SQL statement issued and return values, is output to 
the trace file.  

Table B–1 Using the ocm.properties File to Enable Tracing and Debugging (Cont.)

Property Description
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